
 

 
 

   Duration: 6 Months 
   Eligibility: SSLC or Equivalent 

SCHEME OF STUDY 
DCA 101 PC Software 

DCA 102 Introduction to IT 

DCA 103 Introduction to Programming 

DCA 104 RDBMS 

DCA 105 Lab I-PC Software and Malayalam Computing 

DCA 106 Lab II-Programming in C 

 

 

 



 

PAPER I -PC SOFTWARE 
 

Module - I ( 10 Hrs ) 

Generation of computers, types of computers, micro, mini, main frame & super computers, applications, 
functional units & operation concepts. 

Basic concepts, types of memories from semiconductor RAMs, Memory system Considerations, Basic 
concepts, sequence of operations to execute a complete instruction, hardware control and Magnetic disk 
systems-floppy and hard disk -concept of disk operations-characteristics of different types of disk systems-
magnetic tape systems-concept of optical storage devices. 

Various I/O devices-concept of video terminals-video displays-alphanumeric displays-graphic displays. 

Printers & Plotters ---- Types-Specifications-Characteristics. 

Module - II ( 10 Hrs ) 

Introduction, Different Operating Systems, Loading and Quitting the Operating Systems, Important DOS 
Commands (Internal and External), File and Directory System Concepts in DOS. 

My Computer, Recycle Bin, Internet Explorer, Network Neighborhood, My Documents. 

How to create a Folder, Copying and cutting files, Renaming. 

Programs, Favorites, Documents, Settings, Find, Run, Shut down, application icons 

Module - III ( 10 Hrs ) 

Documentation using MSWord & Open Office Writer 
The Word workspace, Starting and quitting Word, Creating and Manipulating Various documents, Editing of 
proofing files, Merging documents and macros. 
The open command, The New command, The Save As and Save all commands, The Close command, The Page 
Setup, The Print Exit command. 
The Cut, Copy and Paste commands, The Undo and Repeat commands. 
The View menu, The Inset menu, The Tools menu, The Table menu, The Window menu. 
Spread Sheet Preparation Using MS Office & Open Office 
Entering Text, Entering Values, Entering Dates and Times, Moving Around, Selecting Ranges, Using Menu, 
Using Tool Bar, Using Shortcut Menus, Changing entries, Copying entries, Moving Entries,Inserting and 
Deleting cells. 
Changing Character Style, Changing Alignment, Changing Column Width. 
Copying entries between work books, Moving sheets between work books, Deleting sheets, Quitting Simple 
calculations. Doing Arithmetic, Totaling column of values, Naming cells and Ranges. 

Displaying dollars and cents, Formatting decimal places, Formatting dates, Copying style and formats. 

Formulas that make decisions --- Using the IF function, Using the nested IF function, Copying formulas. 



 
Checking Spelling, Printing Worksheets, Preview Worksheets, Setting up the pages. 

Sorting data, Keeping Leading in View, Finding records, Adding and deleting Records, Filtering Records. 

Plotting charts, Sizing and moving charts, Updating charts, Changing the chart type, Using chart auto format. 

Creating Macros, Recording Macros, Running Macros. 

Module - IV ( 10 Hrs ) 

Database Concepts Using MS Access 

Introduction to Database --- Database System Concepts, DBMS and RDBMS 

Creating a database --- Sorting Data in Tables, Fields, Records, Two ways to Create a Database, Creating a 
Database with Database Wizard-Create Tables by using the Table Wizard, Create Tables from Scratch, Field 
Names-Data Types and Filed Properties, Modify Tables Using Design View, Entering Data in a Data sheet, 
Editing Data in a Datasheet, Changing the Width of Columns and Height of Rows, Changing the Order of 
Columns, Setting of Primary Key 

Defining Relationship --- Establish Relationship, Enforce Referential Integrity 

Querying a Database ---- Constructing a Query, Creating the Query, Choose the Tables to Query, Field to Query, 
Entering the Query criteria, Saving the Results of a Query 

Different Kinds of Queries --- Crosstab, Update, Delete, Append, Make Table 

Building and Modifying Forms --- For Entering and Viewing Data, Creating a Form (Design View of Form 
Wizard), Use the Control Toolbox to Add Controls, Modify Format Properties (Font Style, Size, Color, Caption, 
etc.) of Controls, Use of Form Sections (Header, Footers and Detail), Use of Calculated Control on a Form. 

Module - V ( 10 Hrs ) 

Slide Presentation Using MS Office & Open Office 

Creating Template with the Auto Content Wizard. Creating a Presentation with a Template. Creating a 
presentation from Scratch 

Normal Slide, Outline, Slide Sorter, Slide Show, Notes, Slide Master 

Controlling Transitions between slides. Animating Different Parts of a slide. Inserting a Motion Clip.--Including 
Sounds in slides. 

Organization Chart Slide, Creating a table Slide. Creating two column Slide, Module 1: Showing A Presentation, 
Rehearsing/ Timing a Presentation, Designating some slides as “Hidden”, Viewing Slides--Anywhere in a Slide 
Show. 

Presenting with the help of other Office Programs Importing the text from a Word Document.--- Printing a 
Presentation. 

 



 

PAPER II - INTRODUCTION TO IT 
 

Concepts of Information --- Definition of information and examples of information --- Difference between data 
and information with illustration ---- Features of information ---- Categories of information ---- Level of 
information 

Data Concepts ---- Examples of data, data types ----Logical concepts of data: entities, attribute and 
relationships ---- Physical concepts: storage and retrieval, organization of data as files 

Elements of electronic data processing --- Overview of transaction processing --- Processing methodologies, 
Batch, On-Line and Real time processing 

Scientific and Business applications ----Office automation ---- Invoicing Transaction processing--- Back office 
systems --- Financial Accounting --- Payroll ---Geographical Information System (GIS) – features and application 
----Data ware housing and Data marts – features and application 

Multimedia Applications ---Education ---Entertainment ---Edutainment ----Information--Dissemination 

Single user Network application concepts ---Digital Libraries ---Information kiosk ---Web page ---Video on 
Demand 

Internet ----World Wide Web (www) - History, Working ----Web Browsers, Its functions ---Concept of Search 
Engines, Searching the Web ----HTTP, URLs, Web Servers, Web Protocols. 

Html - Concepts of Hypertext, Versions of HTML--- Elements of HTML syntax, Head & Body Sections - --Building 
HTML documents ----Inserting texts, Images, Hyperlinks, Backgrounds and Color controls, Different HTML tags, 
Table layout and presentation, Use of font size & Attributes, List types and its tags, Use of Frames and Forms 
in web pages. 

 

JavaScript ---- Introduction --- Embedding JavaScript into an HTML Document --- Variables --- Literals --- Arrays 
--- Operators ---- Using JavaScript Objects ---- Functions --- If/Then Statements ---- Loops ---Commenting. 

PHP --- Introduction --- The Basics ---- Basic Syntax ---- Code Syntax 

Your First Script --- Error Messages ---- Statements --- Variables 

Arrays ---- Associative Arrays --- Operators: If, Else, Elseif Loops---- Comparison and Logical Operators : 
Comparison Operators, Logical Operators and Arithmetic Operators. 

Introduction --- XML Format and Structure --- XML Elements ---- XML Attributes ---- XML Syntax 1 ----XML 
Syntax 2 

XML Using CDATA for Dealing with HTML Tags ---- Displaying XML into HTML --- XML Parser ---- XML DOM ---- 
XMLHttpRequestObject1 ----- XMLHttpRequestObject2 ---- XMLHttpRequestObject3 --------- Create an XML 
File From a Database1 ---- Create an XML File From a Database2 ----Save XML File on Server. 



 
Distinguish between B2B and B2C---On-line Network and Services---E-Commerce with WWW ---- E- Commerce 
in Service Industries --- On-Line travel Services --- The Electronic Job market --- The Electronic real estimate 
market --- On-Line Stock trading --- Electronic auctions ---On-Line publishing 

Approach to Safe E-Commerce – Overview ---Secure Transport protocols --- SHTTP --- SSL--- Secure Electronic 
Transaction (SET) 

Electronic Cash Electronic payment Schemes --- Payment Processing principles--- Electronic Fund Transfer 
(EFT) ---Master Card/Visa secure Electronic Transaction 

Reasons for Information Security ---- Attacks, Threats and Trust. 

Concepts of Security ---- Basic Cryptography ---- Encryption and Decryption ---- Data Encryption 

Standards ---- Authentication Applications ---- Electronic Mail Security ----Digital Signature and 

Authentication Protocols ---- Digital Certificates and Certification Authority ---- Digital Envelops. 

References 

1. PHP for the WorldWideWeb ---- Larry Ullman ---- Peachpit Press 
2. JavaScript --- Rohit Khurana ---- A.P.H.Publishing Corporation 
3. Fundamentals of Information Technology --- Alexis Leon --- Vikas Publications 
4. Internet for Everyone --- Alexis Leon and Mathews Leon ---- Vikas Publishing House Pvt.Ltd.,New Delhi 
5.  O Level Module --- M 1.2 --- Internet and Web Page Designing ---- V.K.Jain---BPB Publications. 
6. XML Pocket Reference (2nd Edition) ---- Robert Eckstein ---O’ Reilly 
7. Pro PHP XML and Web Services ---Robert Richards 
 

 

 

 

 

 

 

 

 

 

 

 



 

PAPER III – INTRODUCTION TO PROGRAMMING 
Computer Basics --- Algorithms --- Flowchart --- Characteristics of Computers --- Problem-solving using 
Computers --- using flowchart --- What is a Program? 

Functional Units of a Computer --- Input Unit, Output Unit, Arithmetic and Logic Unit, Central Processing Unit 

Classification of Computers --- Palmtop PC, Laptop PC, Personal Computers (PCs), Workstations, Mainframe 
Computers, Supercomputers 

Introduction to Programming Language --- Assembly Language --- Higher Level Programming Language 

Writing a Program --- Input Statement --- Some C Program Examples --- Constants --- Scalar Variables -- - 
Declaring Variable Names --- Defining Constants --- Arithmetic Operators and Modes of Expressions -- - Integer 
Expressions --- Floating Point Expressions --- Operator Precedence in Expressions --- Examples 

of Arithmetic Expressions --- Assignment Statements --- Defining Variables --- Arithmetic Conversion ---
Assignment Expressions --- Increment and Decrement Operators --- Multiple Assignments 

Relational Operators --- Compound Statement --- Conditional Statement-Implementing Loops in Programs --- 
The While Loop --- The for Loop --- The do while Loop-Logical Expressions and More Control Statements --- 
Logical Operators and Expressions --- Precedence--Rules for Logical Operators --- The Switch statement --- The 
Break Statement --- The Continue Statement 

Arrays --- Defining and Manipulating Arrays --- Array Variable --- Syntax Rules for Arrays --- Use of Multiple 
Subscripts in Arrays --- Reading and Writing Multidimensional Arrays 

Functions --- Defining and Using Functions --- Syntax Rules for Function Declaration --- Arrays in Functions --- 
Global, Local and Static Variables-Processing Character Strings --- The Character Data Type --- Manipulating 
Strings of Characters 

Enumerated Data Type --- Creating New Data Type Names --- A Stack --- Simulation of a Stack ---Application 
of Stack-Structures --- Using Structures --- Use of Structures in Arrays and Arrays in Structures 

Pointer Data Type and its Applications --- Pointer Data Type --- Pointers and Arrays --- Pointers and Functions 

Files in C --- Creating and Storing Data in a File --- Sequential Files --- Unformatted Files --- Text Files-Lists and 
Trees --- List Data Structure --- Manipulation of a Linearly Linked List --- Circular and Doubly-Linked Lists --- A 
Doubly Linked Circular List --- Binary Trees 

Recursion --- Recursive Functions --- Recursive Vs Iteration --- Some Recursive Algorithms --- Tree Traversal 
Algorithms-Bit Level Operations and Applications --- Bit Operators --- Some Applications of Bit Operations --- 
Bit Fields 

Reference 

1. Computer Programming in C --- V. Rajaraman --- Prentice-Hall of India 
2. Fundamentals of Computers --- V.Rajaraman --- Prentice-Hall of IndiaDCA 

 



 

PAPER IV - RDBMS 
Introduction to database system concepts ---- Overview of Database System ---- Data Independence ----DBMS 
Terminology ---- Data Abstraction --- Instance -----Schemes--- 

DBMS Components --- DDL --- DML --- Concepts of 4GL --- Data Dictionary --- Database Models ---Relational -
-- Network --- Hierarchical 

ER Model --- ER Diagrams ---- Aggregation --- Generalization --- Cardinality 

Physical storage organizations ---- Hashed and Indexed files 

The relational Model ---- Relational Database Structure ---- Databases---- Tables --- Relations ----Domains ---- 
Attributes --- Tuples --- Primary key --- Foreign key 

Relational Algebra ---- Fundamental operations ---- Select project --- Union --- Difference ----Intersection-Join 
---- Functional dependencies --- Multi valued dependency --- Decomposition of relational schemes ---- 
Normalization 1st, 2nd and 3rd normal forms, BCNF, 4 NF and 5 NF, Typical examples, Case study. 

Integrity Constrains and Advantages of DBMS Concepts ---- Domain Constraints --- Referential Integrity --- 
Database Anomalies --- Data base Triggers --- Transaction Concepts --- Concurrency control --- Lock based 
protocols--- Deadlocks --- Integrity --- Recovery Rollback ----Log based recovery 

Database System Architecture and new applications --- Centralized Systems --- Client-Server Systems --- 

Introduction to Oracle --- Oracle architecture --- Table spaces --- Data files --- Blocks ---- Segments ---Oracle 
server processor --- Users and privileges-Basic structure of SQL-DDL --- DML ---- DCL ---- SQL *PLUS ---Creating, 
updating, deleting records ---Rollback, dropping tables --- Adding constraints ---SQL functions-Simple queries 

Nested sub queries with SQL --- Indexing and Clustering --- Creating indexes --- Listing indexes --- SQL 
statement with indexes ---- Validating indexes ---- Dropping indexes ---Creating a clustered table ---Dropping 
clusters-Views--- Defining a View --- Granting view access to others --- Querying views --- Creating Synonyms 
---Defining multiple table views with JOIN and without JOIN --- Formatting results --- Inserting, deleting and 
Updating data through views --- Dropping views 

.Application development with ORACLE --- Overview of application tools with Oracle ---- Planning and 
designing databases for typical applications ----Business --- Inventory --- Production --- Marketing and 
distribution. 

PL/SQL Programming ---- Simple formatted reports --- Cursors --- Stored procedures --- Triggers --- - Forms and 
Reports in Developer 2000 ---- Sample Program using Control Structures ---Cursors --- 

References 

1.Database Management Systems --- Alexis Leon, Mathew Leon --- Vikas Publication 

2.Database System Concepts ---Korth,Silberschatz, and Sudarsan --- Tata McGraw Hill 

3.Oracle – 7 --- Complete Reference --- Ivan Bayross --- BPB Publications 
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